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If you’re reading this kit then you probably have a story to tell, and you 
want it to be published. You may have written your story, or at least begun 
to research it and gather information. You’re on the road to becoming a 
published author.

This information kit is aimed at people who have already taken several steps 
along the writer’s road, or who are ready to begin. It explains a little of the 
publishing process, especially: 
• 	 the way that we at Aboriginal Studies Press (ASP) choose which books to 

publish and on what basis
• 	 the reason why it can sometimes take a long time to turn a manuscript 

into a published book
• 	 a little on how contracts, rights and royalties work
• 	 other useful details. 

However, it is a basic information kit and so, if possible, you should read 
some of the other guides and articles available for authors. You could start 
with these:
• 	 The Aboriginal Studies Press website. The information under ‘For 

Authors’ and the ‘FAQs’ is particularly useful for new authors.
• 	 The ASP Style Guide. This can be downloaded from the website, or we can 

mail you a hard copy if you don’t have access to the internet.
• 	 Writing Cultures: Protocols for producing Australian Indigenous literature, 

published by the Aboriginal and Torres Strait Islander Council of the 
Australia Council. This can be downloaded free from the Australia 
Council’s website.

This kit cross-references to these publications as they provide the specific 
details of things talked about more generally here. 

We’ve tried to answer all the main queries in a way that’s simple and direct, 
yet brief and factual. We deal with a range of authors, so please allow for 
that if you feel the language is sometimes too simple or too complex.

If you have any queries, call us on 02 6246 1184.

Note that some words are written in bold. These words are explained in the 
margin.

I Want to Publish My Story

publish

To publish something means to 
make it available to the public. 
This can mean printing and 
selling a book, releasing a CD, 
or broadcasting a story on a 
website. It usually means that 
the author or creator earns 
money, but you can publish and 
make your story available free.

http://www.aiatsis.gov.au/aboriginal_studies_press
http://www.aiatsis.gov.au/aboriginal_studies_press/for_author
http://www.aiatsis.gov.au/aboriginal_studies_press/for_author
http://www.aiatsis.gov.au/aboriginal_studies_press/faqs
http://www.aiatsis.gov.au/aboriginal_studies_press
http://www.ozco.gov.au/council_priorities/indigenous/
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Aboriginal Studies Press is the publishing arm of the Australian Institute of 
Aboriginal and Torres Strait Islander Studies (AIATSIS). 

You might have seen the statement that says ASP contributes to AIATSIS’s 
goals by ‘publishing and promoting Indigenous studies’ by creating ‘a 
limited but diverse and quality list of academic and general publications’. 
This is part of our business plan and the AIATSIS Corporate Plan.

ASP is one of a small number of Indigenous publishers in Australia. By 
‘Indigenous’ we mean that our publishing program is controlled by 
Indigenous people, and that we strongly encourage the development and 
publication of Indigenous writers. However, we do publish books by non-
Indigenous authors, and some staff at ASP are non-Indigenous people 
who are experienced in publishing. You need to bear in mind that we do 
not publish something by an Indigenous person simply because they are 
Indigenous: all manuscripts have to be judged to fit into our publishing 
list at the time. The section called ‘How we choose what to publish’ (see 
opposite) details exactly how we choose the manuscripts we accept for 
publication.

What does it mean to be published?

There are thousands of stories to be written and told, and thousands of 
people who want to read them. Publishing is the process of taking those 
stories and making them available to those readers. Our job is to gather the 
stories and present them in the best way possible to the most appropriate 
audience. In doing that we offer editorial advice and pay for all the editorial 
and production costs, as well as marketing, sales and publicity.

This can be a much more complicated process than you might imagine. A lot 
of work goes into making a book happen, and the easiest way to explain it is 
to take you on the journey of three different books towards publication.

Book one is an unsolicited manuscript. The word ‘unsolicited’ means 
that we didn’t ask for, or ‘solicit’, the manuscript — it might have popped 
through the letterbox that morning. The word ‘manuscript’ just means the 
written words, either on a print-out, floppy disc, CD or written in longhand 
in an exercise book. 

About Aboriginal Studies Press (ASP)

unsolicited

Simply means ‘not asked 
for’; it refers in publishing to 
manuscripts sent to a publisher 
by a hopeful author.
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Some publishers don’t even look at unsolicited manuscripts. Here at ASP we 
review all the manuscripts that are sent to us. Apart from it being a matter 
of courtesy, we sometimes offer editorial advice to people submitting 
manuscripts if we think they might have a better chance of being published 
if they presented their manuscript differently. As well, we know that several 
bestsellers started out as unsolicited manuscripts: Sally Morgan’s My Place, 
for example.

However, if you’re going to send us your work you must complete a general 
or an academic manuscript proposal form. These forms ask for information 
about who you think the audience is for your manuscript and how you think 
we might be able to sell it as a book. You might not have a degree in sales 
and marketing but you probably have a very good idea about who’d be 
interested in your book. This information about why you think the project 
is important and who you think the audience for the book might be is very 
valuable.

We assess all manuscripts against a standard set of criteria. The proposal 
form is extremely important so you should give it as much thought as you 
do the manuscript itself (see ‘Marketing’ later). If you have any queries, call 
us on 02 6246 1184.

The second book began its life as a commissioned manuscript. That means 
that we at ASP, sometimes taking advice from specialists, came up with the 
idea for the book and paid an author to write it for us. 

Why do publishers commission books? The main reason is to fill a need. For 
example, the Board of Studies might require all Year 10 students to study 
an Indigenous language, but if there aren’t any suitable textbooks available 
for those students then a publisher might commission an author to write 
such a book. Alternatively, at ASP we might believe a high-profile sports star, 
politician or elder should have their story told. 

There is a third option. Sometimes ASP chooses to publish a mixture of 
unsolicited and commissioned work. For example, an author might let 
us know what they’re working on — say, a thesis in anthropology, or a 
biography of a community elder or a well-known Aboriginal or Torres Strait 
Islander painter or writer. In that case, ASP might work with the author 
to suggest the best way to develop the thesis, or the biography, into a 
publishable manuscript.

How we choose what to publish

Whether a manuscript is commissioned, unsolicited or a mixture of the two, 
one thing remains the same: to go any further along its journey towards 
publication the manuscript must be assessed. The first level of assessment 
is by ASP itself (under advice); the next level is by specialist assessors, about 

manuscript

The word ‘manuscript’ is 
from the Latin word for 
‘hand-written’. These days, 
most writing is generated by 
computer, but ‘manuscript’ 
(often shortened to ‘ms’) is still 
used in publishing to describe 
an unpublished work.

commission

When publishers commission 
a manuscript, they instruct an 
author to produce a work to 
its specifications. The author 
doesn’t decide the subject or 
the scope, but produces what 
is required — commissioned 
— by the publisher.

http://www.aiatsis.gov.au/__data/assets/pdf_file/4817/Book_Proposal_gen.pdf
http://www.aiatsis.gov.au/__data/assets/pdf_file/4816/Book_Proposal_acd.sch.pdf
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50% of whom are Indigenous; the final level is by our Publishing Advisory 
Committee. This committee advises the Director of ASP and the AIATSIS 
Principal — the person who signs our author–publisher contracts. The PAC 
members come from a range of backgrounds. The majority are Indigenous 
and they all have cultural, academic and writing knowledge.

Not all manuscripts make it to the PAC. We receive more manuscripts 
than our resources (both financial and staff ) allow us to publish. That 
means we can put forward only those manuscripts that meet the needs of 
our publishing list at the time. We use an assessment grid when making 
judgments about manuscripts. This grid includes judgments about things 
like the content, the scholarship (if relevant), the writing, the author, 
how it fits with other books we’ve published, and how much of our staff 
and financial resources it would require. All of this allows us to make an 
equitable judgment.

So what are we looking for in a manuscript? 

If it’s a general book it’s got to be both a good story and well told. If it’s an 
academic book then the scholarship has to be sound and provide a valuable 
addition to the literature in the relevant discipline.

Some manuscripts are not accepted for publication because they’re not 
sufficiently well written. You might have read high-school teacher Frank 
McCourt’s Angela’s Ashes. Lots of people had written similar stories, but the 
world only took notice because he told his story so well. In a similar way, the 
stories of the survivors of the Stolen Generation are gradually being told, 
and deservedly so. Writing their stories makes sense of these authors’ lives 
for themselves while reminding other Aboriginal and Torres Strait Islander 
people who read them about their history. These stories are eventful, 
gripping and often traumatic. They’re stories that the wider community 
needs to hear too. But this doesn’t in itself make a good book: we need an 
author with the passion, skill and ability to make that happen.

When we receive a manuscript that has lots of potential but hasn’t been 
sufficiently well written we make a choice about what to do. This will 
depend on the manuscript and whether the writer wants to keep working 
on it. Sometimes we offer advice to the writer about how they might rewrite 
the manuscript. If a writer is pretty close to having a publishable manuscript 
we might issue a contract to publish and then offer editorial support. For 
example, the first time that you write your story down it may be a bit rough 

Please remember that if ASP doesn’t choose to publish your manuscript 
you shouldn’t take it to mean we don’t think your story — or your life, if 
it’s an autobiography — is not important. As you’ll see below, we have 
a range of suggestions for authors whose manuscripts we don’t publish 
in book form.
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and ready. This first effort is called the first draft, and it may contain spelling 
mistakes, bad grammar, structural inconsistencies (things told in the wrong 
order) and other errors. Each time you go over your manuscript, making 
corrections and improvements, you are creating a new draft. Thus you’ll hear 
editors refer to ‘third draft’, ‘fourth draft’, ‘final draft’ and so on.

Unfortunately, we rarely have money to pay an author while they do the 
rewriting or to pay someone else to do it for them.

At other times we might suggest the author look for a different way of 
sharing the story. For instance, we have a section on our website called 
‘Our Tracks’. It’s where we publish small sections of longer manuscripts. 
These are often life stories or community stories and the authors are paid 
a small amount to have their stories there. For authors who don’t want 
to keep working on their manuscripts, the AIATSIS Library chooses some 
manuscripts that it stores and makes available to visitors and researchers.

We sometimes receive theses from academics seeking publication. Our 
usual response is that a thesis must be rewritten for a wider audience. 
By definition, a thesis is written for examiners: just a handful of people. 
In contrast, a book needs to reach a much wider audience. ASP provides 
information about rewriting a thesis for publication on its website.

Whatever kind of manuscript you’ve written, if we don’t accept your 
manuscript for publication and you don’t take up one of the options 
mentioned above, you’re free to offer it to another publisher.

A second judgment we make is how interesting the manuscript would be 
to a large audience, and whether it would sell. That decision is shaped by 
whether we think we can market, publicise and sell the book. Although you 
may have written your manuscript especially for other Aboriginal and Torres 
Strait Islander people, that audience may not be large enough on its own for 
us to publish. ASP markets and sells its books to non-Indigenous Australians 
as well as to libraries and overseas.

That doesn’t necessarily mean you have to change the structure of your 
manuscript or the writing style. Even in the recent past Aboriginal people 
wanting to be published found they were pressured by publishers to 
change Aboriginal English into standard English. Ruby Langford-Ginibi is 
one published author who’s written about this experience. Your writing 
doesn’t have to be standard English, but it does have to match the kind of 
manuscript you’ve written. If you’ve written an academic piece of writing it’ll 
probably be in standard English, although quotations of people speaking 
might be in language, Kriol or Aboriginal English. However, if you’ve written 
a community history or are quoting other people’s words in a biography, 
you should write in whatever style matches the way those people speak. If 

editor

A person who makes some-
thing ready for publication. 
There are different types of 
editors: a copy editor might 
suggest quite large changes 
to the way a story is told 
(‘structural’ changes) while at 
the same time correcting a 
story’s spelling, grammar and 
consistency.

draft

An early form of something 
(a piece of writing, a picture) 
before it’s been revised and 
refined.

http://www.aiatsis.gov.au/aboriginal_studies_press/find_a_book/online_stories/our_tracks
http://www.aiatsis.gov.au/__data/assets/pdf_file/3648/rewriting_your_thesis.pdf
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you’re writing an autobiography you might choose to write in Aboriginal 
English, much the way you speak, although some authors prefer their life 
story, in book form, to be in standard English. Although they sometimes 
find it a bit confronting, non-Indigenous Australians, and others reading in 
English, have now become used to reading novels written by people writing 
in non-standard English. You too might have read books by people writing 
in their own style of English, people from places like Ireland and India, or 
African-Americans from the USA.

Importantly, each book we publish needs to have something special 
about it; it has to be different in some way from all the other books already 
published. An academic manuscript usually differs from others because of 
its subject matter, so it’s obvious what’s special about it. However, if you’re 
writing a more general book — say a community story — then it needs to 
be one that records your history or your language and culture so that others 
— people who don’t know your mob — can read it and understand it. On 
the other hand you might be writing the biography of someone whose 
life was similar to others, and so in that way it represents the lives of lots of 
people, but perhaps it’s the story of someone who provided leadership to 
their community. Whatever story it is, it has to be written well enough so 
that it reaches out to a wider audience. 

If you haven’t already looked in a library, community or language centre 
or checked out a few bookshops to see what’s already been published and 
where a book like yours might fit, now’s the time to do so. If you don’t have 
easy access to a bookshop you might be able to search on the internet 
instead. Read as much as you can, especially other books that are similar in 
style to yours. Learn from them what works well. If it’s a general book, you 
can try reading your story to others. If they lose interest it might mean that 
you have to cut some bits out that are getting in the way of your main story. 
Writing well is hard work, so be prepared to put in some time.

At ASP, while we understand that not every book we publish will make a lot 
of money we can’t become a financial burden on AIATSIS. We must strike 
a balance between writers (both Indigenous and non-Indigenous) whose 
writing reflects different aspects of Aboriginal and Torres Strait Islander 
culture, history and society with what we believe we can sell. After all, if 
only a few people buy our books then we haven’t achieved AIATSIS’s aim of 
promoting Aboriginal and Torres Strait Islander studies.

We don’t set out to have our books on the bestseller lists, though it would 
be nice if they were. Instead, we aim to publish culturally significant and 
influential books. We often seek endorsements (comments) from well-
known people and place these on the back covers of our books. Increasingly 
we’re receiving positive reviews of our books in newspapers and journals 
and some of our authors are interviewed on radio. 

Mary Duroux (R) author of  
The Rain Flower, and Karen 
Briggs, illustrator, signing 
copies of the book at the 
launch. Photo: AIATSIS.

Aboriginal Studies Press also 
has a small bookshop at its 
premises in Canberra.
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Sometimes our books have been researched over a period of years, and that 
research has been supported by an AIATSIS research grant. That, and our 
desire to work in an ethical and culturally sensitive way with our authors, is 
what marks out Aboriginal Studies Press from other publishers.

Issuing a contract

If a book is recommended by the PAC and accepted by the Principal for 
publication then the next step is for both parties — the author and ASP 
— to agree how they’ll go about it. ASP’s offer to publish a manuscript 
may depend on the author rewriting sections based on the assessors’ 
comments, or perhaps making the manuscript shorter or longer. The author 
will also agree to provide the finished manuscript at a certain time and sign 
a warranty, or a set of promises. (See more about this in ‘Important Notes 
for Authors’.) For its part, ASP will agree to publish, promote and sell the 
book. These things are written down in a legally binding document called a 
contract.

A good contract describes exactly what each party will do, and what they 
can expect in return. Your contract will spell out the things you will need 
to do before submitting the final manuscript. This means ASP will expect 
you to have done the basics: checked the spelling as much as possible, 
sought cultural permission to tell a community’s story, sought permission 
to use quotations (other people’s words) or photographs, and approached 
archives or libraries to reproduce images you want in your book. This can be 
an overwhelming task for new writers but at ASP we offer support to all our 
authors, especially new ones.

The ASP Style Guide contains vital information on preparing your manuscript 
and it contains all the details you’ll need in order to make it as clean as 
possible. However, it’s quite complex as it needs to cover lots of different 
kinds of manuscripts. You might prefer to read the brief notes about how to 
present your manuscript at the end of this guide (see ‘How to Present Your 
Manuscript’). We’ve also included a copy of the cover sheet and proposal 
form that has to be attached to the manuscript you submit. 

Contracts also describe things like the publishing schedule, payments, 
royalties and rights. We’ve avoided legal-speak as much as possible in our 
contracts but, even so, many of these words can sound intimidating. What 
do they all mean?

The schedule is the timeline for publication. You’ll agree with ASP a date for 
delivering your final manuscript. ASP will then advise you of the expected 
publication date. You might be surprised at first at the time difference 
between the two dates, often several months. To understand why this can 
be so, go to the section titled ‘The Publishing Process’.

contract

A legally binding agreement 
between an author and a 
publisher setting out the 
details of what each party 
promises to deliver to the 
other.

http://www.aiatsis.gov.au/aboriginal_studies_press
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ASP will indicate to you the anticipated print run. ASP doesn’t print its own 
books, we get specialist printers to do that work. The number of copies we 
decide to print will depend on a range of factors: how many people we think 
we can sell the book to; how many other books there are on a similar subject 
or in a similar style; how easy the book will be to market and publicise, etc. 
One way to think about it is to remember that publishers — including ASP 
— sell the majority of their books through bookshops. This means your book 
will sit alongside other, similar books. You might think your story is unique, 
after all that’s why you wrote it. But the bookseller will still categorise it 
under headings such as History, Aboriginal Studies and Biography. For 
further information on this, see the section titled ‘The market’.

The selling price and the royalty are often closely linked. The author usually 
receives a percentage of the price that the book’s sold for. It’s important 
to remember that the price you pay for a book in a shop or via the internet 
isn’t the amount the author or the publisher receives. Ten per cent of the 
recommended retail price (RRP) is GST. Distributors and booksellers will 
need their portion to cover the cost of freighting the book around the 
country and selling them in shops; this can be up to 60% of the RRP. 

The rights of a book refer to what you agree to allow the publisher to do 
with your manuscript. This includes things like the place of publication or 
the parts of the book that can be sold on to others. For example, a magazine 
or newspaper might want to feature an extract from your book. If they’re 
prepared to pay to use it you would be due part of that fee. There are other 
sources of income for authors like money from the photocopying of books 
by organisations and universities and the federal government’s Public 
Lending Right (PLR) where small amounts are paid to authors and publishers 
for books borrowed from public libraries.

As mentioned above, the contracts offered by Aboriginal Studies Press 
are fair, but a contract is a legally binding document, so seek independent 
advice if you wish to. Contact us first on 02 6246 1184. If you want an 
independent opinion we recommend that you approach the Australian 
Society of Authors (the ASA, see ‘Resources and Further Help’) for advice.

royalty

The part of the income 
generated from book sales 
that’s paid to the author. 
Authors are paid royalties 
on books as they sell, not 
on all the copies printed. An 
alternative to a royalty is a fee 
where the author is paid an 
amount of money for their 
writing, usually before, or on 
publication.

rights

‘Rights’ defines the limits the 
author allows the publisher to 
license, or sell your work on 
to other people. It can refer 
to territories (for example, 
are you just allowing the 
publisher to produce 
the book in Australia, or 
internationally?) or media 
(will you allow just a book, 
or a CD version too, or allow 
parts to be serialised in a 
magazine?) This is a tricky 
area that deserves your full 
attention.

http://www.asauthors.org/scripts/cgiip.exe/WService=ASP0016/ccms.r
http://www.asauthors.org/scripts/cgiip.exe/WService=ASP0016/ccms.r
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Jimmy’s story*

Planning to become an author? Don’t give up your day job! That’s the 
advice of three-times published Jimmy Heron, of Far North Queensland’s 
Calbanya community. Jimmy works for the Australian Quarantine 
Inspection Service at Weipa, and had his first book — What’s that funny 
fly? — published in 1997. Written and illustrated by the author, What’s 
that funny fly? aimed to raise awareness among FNQ’s schoolchildren 
about the dangers of invasion of pest insects via trade in the Torres Strait. 
Published by the Queensland Government Printer, it sold a thousand 
copies; and earned Jimmy the princely sum of $372.75. Not bad for a 
year’s work!

Jimmy’s second book, a novel for teenagers, was published by a well 
known Queensland publisher in 2001. Lost Cousins sold well, and was 
nominated for a major Literature Award: Young Adult Fiction section in 
2002. This time Jimmy’s royalty agreement was higher and the book sold 
over 2000 copies, and so for the almost two years it took to write Lost 
Cousins Jimmy made just over $1,200. About $50 a month.

His most recent book, Leichhardt at Calbanya, 1841, was published by an 
Indigenous publisher in 2005. This time, Jimmy decided to donate the 
royalties to the community development fund. 

‘What the hell; I’d never retire from it!’ he laughs. ‘I enjoy my writing, 
and its nice to get something back from it. But my best selling book, Lost 
Cousins, made me less than my nephew’s pension cheque: go figure!’

Some authors do make a handsome living from their writing, but the 
Australian Bureau of Statistics shows that these writers are in the minority. 
The average income for writers in Australia is less than $16,000. And that’s 
income, not profit: don’t forget the cost of your computer, your paper, 
your CDs . . . oh, and of course your tax!

*This isn’t a true story, but it’s typical. It’s based on a few people’s experiences.
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Authors are often exasperated by the time it takes to turn their manuscript 
into a finished book. This is especially the case if it’s a manuscript where 
the information might go out of date, or where the subject of a biography 
is elderly. ASP will take into account all these things when scheduling your 
manuscript for publication, but we’re often scheduling books we’ve already 
agreed to publish twelve to eighteen months ahead.

We’ll do everything we can to let you know when your book is likely to be 
published. Using that information we’ll let you know the best time for you to 
deliver your manuscript. Remember that you’ll probably still be working on 
improving your manuscript even after you’ve been accepted for publication 
and before you have to submit the final manuscript. After that, your 
manuscript might be up to a year in production. Why so long?

There are lots of reasons, some that we can control and some that we can’t. 
The first comes down to the quality of your manuscript. If you present 
a ‘clean’ manuscript — a draft you’ve gone over several times and have 
worked hard at to remove all the errors — then that means less work for us. 
However, the less you’ve done, the more we have to do. Once again, this is 
where you should look at our Style Guide. This contains all the information 
you’ll need to prepare a clean manuscript.

It’s important that you provide all the parts of the manuscript. Permissions 
must be sought for photographs, song lyrics, maps and when you’re using 
other people’s words. In fact, anything that you’ve used from somewhere 
else. Under the contract this is your responsibility, but ASP can help. Look 
at the Permissions information we provide on our website If you still have 
questions, call us on 02 6246 1184.

In addition, we need to know that you’ve checked and double-checked the 
facts. We simply can’t afford to publish a book where the facts haven’t been 
checked, permissions received and acknowledgments made. The reputation 
of AIATSIS is at stake; so too is yours, as an author. If readers find that you 
made a mistake about someone’s name, or the spelling of a language group 
(and if you did get it wrong, you can be sure that someone will notice) then 
everything else you’ve written might become doubtful in their eyes.

We don’t make any changes to a manuscript without the author’s approval. 
But this checking and double-checking can take months. However, it’s 
important to get this stage right; it’s like the foundation of a house.

Some books feature dozens 
of photos, quotes (other 
people’s words or writing) 
and references (‘pointers’ to 
the documents or people you 
sourced your information 
from). Gathering and 
acknowledging these sources 
requires a huge amount of 
work from both the author and 
the editorial team. Before it 
could be published the book 
Cleared Out was checked, 
rechecked and rechecked 
again to ensure that the 
facts were correct, sources 
correctly acknowledged and 
permissions received.

The Publishing Process

http://www.aiatsis.gov.au/aboriginal_studies_press/for_author/permissions
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The last reason for the length of time it takes to create a book from a 
manuscript is one that might not be obvious to you. The publication dates 
we set are influenced by several things: our budgets; the other books we’re 
publishing that month; and whether there’s a special event that would 
make a particular month the best to publish in (perhaps a conference or a 
writers’ festival). ASP will use all this information to set the most appropriate 
publishing date for your manuscript. We generally don’t publish during 
November to January as, at that time, the bookshops are crowded with 
Christmas gift books and the media isn’t operating normally, so your book 
wouldn’t get the coverage it deserves.

When the editorial process is close to completion the design team will 
begin. We have designers in-house, though occasionally we’ll engage a 
freelance designer. ASP will ask you for ideas about what the cover might 
look like. We’ll also show you the copy for the ‘blurb’ (the information on the 
back cover), and we may ask you for the names of important people who 
might provide favourable comments to use on the cover. However, under 
the contract, ASP will have final say over the way the cover looks. Naturally 
we work with our authors to ensure that any artwork or cover ideas are 
culturally appropriate to the story being told. We also use our experience as 
well as feedback from the sales and marketing people whose job it is to sell 
the books. Creating a good design is both an art and science, and it takes 
time to get it right.

We’ll consult with you throughout the process, so when you see the first set 
of proofs there shouldn’t be too many surprises.

When your manuscript has been edited and checked, designed, laid out 
and proofed, and an index created (if necessary), it will be ready to go to 
the printer. The process of printing, binding and delivery to a warehouse 
can itself take a few weeks, so when the editorial time, design time and 
printing time are added you’ll be lucky to get much change out of six to 
nine months.

The market

ASP works hard to promote its books, but the market for new books in 
Australia is very crowded. Each year more than 5000 Australian books are 
published. That’s in addition to all the ones that are imported from overseas 
(mainly the UK and the USA). On the day that your book is published about 
13 other Australian books will be published too. The day before, 14 other 
books will have been published, and the day after 14 other books will be 
published (as well as all the overseas titles). And so on. 

Making your book stand out from this crowd isn’t easy. But this is where 
your hard work at the very beginning — when you filled in the proposal 

proofs

A proof is a printout, usually 
on A4 paper (or sometimes an 
electronic version like a PDF) 
of the book in progress. There 
will be several stages of proofs. 
Authors usually see and are 
asked to check the first page 
proofs and the cover proofs.
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form — comes into play. This was the form that asked you for information 
about who you thought was the audience for the book and how you 
thought we might be able to sell it.

If your book has a national focus then this will, of course, offer the largest 
audience. Books with a regional focus will do best in that region, but careful 
structuring of the story early in its life can help it translate to other regions 
and communities. For example, the ASP book Mutton Fish looked at the 
abalone-gathering culture of the south coast of New South Wales, and this 
is where most copies of the book have sold. However, the authors — Beryl 
Cruse, Stewart Liddy and Sue Norman — also did interviews in Western 
Australia, and it was launched by Social Justice Commissioner Tom Calma at 
a Native Title Conference in Coffs Harbour (mid-north coast NSW) who found 
similarities to his country in the Northern Territory.

The key is in the preparation. In the same way that the ASP Style Guide will 
help you to produce a clean manuscript, the proposal form will help you 
to focus your thoughts on the book’s market. It’s this work that makes 
the difference and will help your book to stand out from the crowd. If you 
compare your manuscript to the proposal form it will help you keep focused 
on what’s important about your manuscript.

Mutton Fish is a regional 
study that, through careful 
writing and marketing, 
speaks to a national 
audience. It’s vital to think 
about the book’s final 
audience early on; this is 
where the proposal form is  
a useful tool.
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Author’s warranties (promises)

When you sign a contract with a publisher, part of that contract will 
include an ‘author’s warranty’. Authors’ warranties are a set of promises. 
In this part of the contract authors state that they have the right to enter 
into the contract, that their manuscript is original (that is, it hasn’t been 
copied from someone else), that it doesn’t to your knowledge contain 
anything defamatory. Writing a book is not the time to play out or publicise 
disagreements with other people. None of us is free to say whatever we like 
about other people in a book, even if we think it’s true.

Read this warranty carefully. If there are any parts of your work that you have 
copied from elsewhere then the source must be acknowledged (the quotes 
and references we mentioned earlier). You can’t pass off other people’s work 
as your own; any work from outside your control is not yours to sell, and so it 
must be properly credited. You may even have to pay someone to use their 
material.

Similarly, be extremely careful when writing about real people, places 
and events. It simply isn’t enough to change Bill Smith’s name to Bert 
Brown if the real, living Bill Smith, his friends, family and community, will 
instantly recognise himself. If you tell a story that shows  ‘Bert Brown’ 
doing something that would affect his reputation, and Bill Smith realises 
that you’re probably talking about him, he may choose to take legal action 
against you and us, the publisher. These are the laws of defamation.

We at ASP will ask you to tell us if you’ve written about anyone who’s alive 
and whether you’ve used their real name or not. That way, we can choose to 
take legal advice about whether changes to the manuscript are necessary. 
Even if you believe what you’ve said to be true, you may need to change 
parts of your manuscript.

Writing other people’s stories

A number of the manuscripts we receive are from people who’ve written 
other people’s stories. This is where two people, or several people, have 
worked together, in collaboration. The collaboration might be between 
non-Indigenous authors with Indigenous authors, sometimes people who 
wouldn’t feel able to write their story without help. Some very successful 

Important Notes for Authors



14 • An Information Kit for Indigenous Authors

examples published by ASP are Country of the Heart, Cleared Out and Mutton 
Fish. A lot of work went into creating Cleared Out but it was worthwhile: in 
June 2006 it won the Western Australian History Award and the Western 
Australian Premier’s Book Award for 2005. Sometimes both the author (the 
person writing the story) and the subject of the biography (the storyteller) 
are Indigenous. Kim Scott’s successful and collaborative Kayang and Me is a 
book he wrote with his Aunty Hazel Brown (Fremantle Arts Centre Press).

These can be very powerful books and many of the stories wouldn’t be 
told without this collaboration. That said, it can be a long and sometimes 
challenging journey for everyone involved. You’ll need to think about 
how you go about it, who is acknowledged as the author and who earns 
royalties (see ‘Copyright, moral rights and indigenous intellectual property’ 
opposite). You also need to consider the warranties or promises you make 
when signing your contract, especially the law of defamation. 

If you’re writing a community story you need to work closely with the 
community on every step, checking and rechecking. You have to make sure 
all cultural protocols are followed and that you have the permission of the 
cultural custodians as well as other community members. Everyone’s views 
need to be listened to and respected, and then you will have to find a way of 
bringing it all together in a readable manuscript.

If you’re writing a biography you should remember that one person’s story 
is also a family and community’s story, and these other people’s views need 
to be taken into account. Sometimes the process can be tricky, depending 
on your relationship with the person you’re writing about. If they’re an elder, 
and part of your family, you might find they don’t talk to you as freely as 
you’d like. Some older Aboriginal and Torres Strait Islander people want their 
stories told and will be happy to work with you, but in remembering their 
lives they’ll be drawing on what might be painful memories they haven’t 
talked about before. You’ll need to allow lots of time and be patient. Fiona 
Doyle, who wrote Whispers of this Wik Woman (University of Queensland 
Press), has talked about the collaborative process in writing her book.

Even if you’re writing your own life (an autobiography), you’re writing about 
other people’s lives too — your friends, family and community — and they 
might not all remember things the way you do. Allowing people to read 
your manuscript as you’re working on it will give you the chance to take 
into account the way other people feel. Some people writing their own life 
story find that the process of writing is a healing process for them, as well as 
others who may have had some of the same experiences. Depending on the 
story, it might also be one that’s important for non-Indigenous Australians 
to learn about.
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Copyright, moral rights and Indigenous  
intellectual property 

Copyright does not apply to ideas but to the words used to write them 
down. There is no copyright on ideas, so if you have a great idea for a story, 
keep it to yourself! Book titles aren’t copyrightable either, so the same 
applies until the book is about to be published. Once you write a story down 
then your particular, individual expression of that idea is copyright. You 
don’t need to do anything to ensure copyright, you just need to be able to 
show you wrote the words. You might like to put the copyright symbol ©, 
along with your name and the year you published it, on every page (© Jake 
Johnson 2006).

Copyright is seen as an ‘economic’ right as it can be bought, sold and 
traded. ASP’s contract won’t ask you to sell your copyright, to us or anyone 
else. You’ll keep your copyright in the manuscript, but through the contract 
you’ll allow ASP to produce it as a book and sell it. (If you sell your copyright 
it’s called an ‘assignment’; if you lease it, or allow someone to use it, with 
conditions, it’s called a ‘licence’.) ASP will then pay you a fee or royalties 
each time someone buys a copy of the book. It happens in a similar way 
with music. For example, when you buy a music CD you don’t own the music 
itself; you own the disc and the plastic case and paper sleeve. What you’ve 
done in buying the CD is to pay a small fee allowing (licensing) you to listen 
to that music. Parts of that fee go to the artist and the publisher.

Moral rights and Indigenous intellectual property (sometimes called IIP) are 
complex but important ideas, well beyond what we can include in this basic 
guide. A quick introduction follows but you should refer to Writing Culture: 
Protocols for producing Indigenous Australian literature for more information.

If copyright is seen as an economic right, then moral rights are seen as 
‘non-economic’ rights. That is, they protect the right of a creator to be 
acknowledged as the creator of the work and they protect the work from 
derogatory treatment. They don’t offer a financial return to the creator, and 
they cannot be sold, traded or passed on to anyone else. 

Intellectual property has several forms: copyright (mentioned above), 
which relates to the expression of ideas (writing, music, painting); patents 
(covering inventions); and trademarks (symbols associated with a company 
or a service). Most discussion around Indigenous intellectual property 
relates to the visual arts and the creators’ efforts to defend their work from 
fakes and imitation or to artistic expression that falls outside traditional 
Western copyright laws (such as body painting and rock art).

However, Indigenous intellectual property relates to literature too. As 
mentioned above, some stories can ‘belong’ to a group of people rather 
than an individual. This needs to be recognised, especially when a third 
person is involved in the expression of that group story.

This cd presents the 
wangga songs of Bobby 
Lane, a Wadjiginy man 
from Belyuen, NT. The 
songs belong to the 
community.

http://www.ozco.gov.au/council_priorities/indigenous/
http://www.ozco.gov.au/council_priorities/indigenous/
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The closer that your manuscript is in its presentation to recognised industry 
standards then the easier it will be for us to make a fair and equitable 
comparison with other manuscripts.

The instructions that follow are for setting up a document in Microsoft Word. 
Other programs vary a little, but most are similar. Your manuscript might not 
have all these features; just use what’s relevant to you.

Page setup Before you begin writing, set up your master page to A4 
size, portrait format (i.e. tall and thin). Give your page wide 
margins: 3 cm top and bottom, 4 cm each side. This might 
seem like a lot of ‘white space’, but it makes reading the 
manuscript much easier. To make these settings, go to:

File > Page Setup > Paper Size > Orientation

File > Page Setup > Margins

Typeface Use an easy-to-read typeface like Palatino or Times New 
Roman. Don’t use lots of different fonts as this can make 
your manuscript harder to read. Use 12 point except for 
headings (see ‘Headings’ below).

Use bold only for headings.

Use italics for the names of books.

You can also use italics for emphasis, but don’t overdo it.

Format > Font > Font Style

Paragraph settings 
(line spacing, 
paragraph and  
word spacing)

Set your line spacing to ‘Double space’. As with the wide 
margins, this might look like a lot of wasted space, but will 
give the editor or assessor room to make comments on 
your manuscript.

Don’t use the Enter key except when you want a new 
paragraph.

Don’t add an extra space between paragraphs.

Format > Paragraph > Spacing > Line Spacing

Word processing is not like using a typewriter, so use only 
one space between words and after all punctuation.

Justification Don’t justify your text, that is, don’t have the right-hand 
side of sentences ‘pulled’ across to form a straight, vertical 
line. Use left alignment, like this table.

Format > Paragraph > Alignment

How to Present Your Manuscript
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Headings Headings and subheadings help give your manuscript 
shape. Use no more than three levels of headings, e.g. a 
chapter head and then two levels of subheadings.

Set them this way:

Chapter 1 (14pt bold)

First level subheading (12pt bold)

Second level subheading (12pt italics)

Format > Font > Font Style

Capitalisation Set headings with Initial Capital Letters.

Proper nouns always take initial capital letters, e.g. Sydney, 
Larrakia. 

Avoid using ALL CAPITAL LETTERS or all lower case.

Format > Font > Font Style

Page numbering Number all the pages of the manuscript throughout (not 
chapter by chapter) in the lower right-hand corner.

Start each chapter on a new page.

Insert > Page Numbers > Position > Alignment

Headers Establish a header to appear on every page of your 
manuscript. Include the name of the manuscript and your 
name.

You could include a copyright symbol, your name and the 
year (© Jake Johnson 2006).

View > Header and Footer

Spelling Use UK English, not American or Australian.

Tools > Language > Set language > UK English

Use Spellcheck, but make sure Spellcheck’s suggestions 
make sense to you. Aboriginal language names and place 
names won’t be in the dictionary, so check them carefully.

Tools > Spelling and Grammar

Photographs Include only photocopies with the printout of the 
manuscript. Do not insert them in the manuscript; instead, 
type in ‘Photo 1 here’.

Captions to the photographs can be supplied now, or 
written later.

Read about ‘Permissions’ on the ASP website.

Tables Include these in the main text.

Number them by chapter, e.g., Table 1.1, 1.2, 2.1, 2.2.

Table > Draw Table

Word count Check the number of words in your manuscript matches 
your contract.

Tools > Word Count

http://www.aiatsis.gov.au/aboriginal_studies_press/for_author/permissions
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Frequently Asked Questions (FAQs)

I’ve just written my life story and I think lots of people will want to read it. If I 
send it to you to be printed why can’t I say what it’ll look like?

ASP is a publisher, not a printer. We make the choices about what to publish 
by looking at a lot of factors, especially taking into account our budgets and 
the number of staff we have working with us. We also take into account the 
number of other books we’re working on at the time, what other books we 
(and other people) have published, how good the story is, and how well 
written it is. Even though we publish some books which have a regional 
focus, as a national publisher we need to work out whether we think it will 
appeal to a large enough number of people and whether we can sell the 
book to those people. ASP pays all the costs of publishing — which can be 
a lot of money — and we use our experience in publishing to help make the 
right decisions in the editing, design and marketing. Go to ‘For Authors’ on 
our website to find out more.

I want all my mob to be able to afford my book and some of them don’t have 
a lot of money. Can you make sure my book sells for no more than $20?

We understand that you want your mob to be able to afford your book 
but we have substantial costs to recover on all books. If you provide your 
manuscript having checked it carefully, it’ll probably take us less time and 
money to produce it. But one of the largest costs is the printing, so if your 
manuscript is a large one it’ll cost more to print than a smaller one.

Talk to us early on about your concerns. We offer authors a discount on their 
own books (40% off the retail price) so you might want to buy books for 
your mob using your discount and then give them away.

I know exactly what I want on the cover — I’ve even done the painting. Why 
does ASP want to have control over it?

We always ask authors what they’d like to have on a cover. But good design 
and selling books in bookshops and through catalogues is a specialised 
business. Your idea for the cover might really suit the content of the book 
but it might not be the best image to sell the book, and bookshops are very 
competitive places.

http://www.aiatsis.gov.au/aboriginal_studies_press/for_author
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Australian Society of Authors

This is the professional association for Australia’s literary creators, with 
almost 3000 members across Australia. It lobbies for authors’ rights, 
produces the journal Australian Author, offers a contract advisory service, 
runs mentorships for new and emerging writers, including Indigenous 
writers, and offers advice about writing, copyright and publishing.

Australia Council for the Arts

The Australia Council for the Arts is the Commonwealth Government’s 
arts funding and advisory body. It provides grants in (among other things) 
literature and Aboriginal and Torres Strait Islander arts to artists and arts 
organisations.

Copyright Council

The Copyright Council is an independent not-for-profit organisation. It 
provides information, advice and training about copyright in Australia. 
You can download very helpful information sheets from their website, or 
purchase publications.

AustLit

AustLit is a non-profit collaboration between ten Australian universities and 
the National Library of Australia. It provides information on hundreds of 
thousands of creative and critical Australian literature works relating to more 
than 75,000 Australian authors and literary organisations, from 1780 to the 
present day.

OzLit

Includes information about publishing and authors, as well as information 
on Indigenous authors who have already been published.

Resources and Further Help

http://www.asauthors.org/scripts/cgiip.exe/WService=ASP0016/ccms.r
http://www.ozco.gov.au/
http://www.copyright.org.au/
http://www.austlit.edu.au/help
http://home.vicnet.net.au/%7Eozlit/
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